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Additional Dashboard Item Options

REPORTS DASHBOARD

ADDITIONAL DASHBOARD ITEM OPTIONS

Reports Dashboard is an application that graphically displays critical busi-

ness information onto a dashboard which can be viewed in Realtime.

In Reports Dashboard, when adding or editing dashboard items, there are

multiple options you can use to customize your dashboard report.

Access: Reports Dashboard Icon > Log In

The Reports Dashboard application will open.

DASHBOARD MENU OPTIONS

* When adding or editing a dashboard, if you right click on a dash-
board item column header or title,a menu with additional
options will be displayed.

®  Note: Some of the options displayed in
the right click menu are pertinent to the
selected control type (dashboard item) and
won't be available if a different control

type (dashboard item) is selected.
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SHOW OR HIDE DASHBOARD ITEM TITLE

1. Click on Show Captions on either the Design Tab or the right click
menu.
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1. The Show Caption button on the Ribbon will become disabled (‘whit-
ish' in colour).

2. The title of the selected control type (dashboard item) will no longer

be displayed.
®  Note: To display the title of the selected con-
trol type (dashboard item) again, repeat the pre-
vious step. The now enabled Show Caption
button on the Ribbon will be 'bluish' in colour.
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DUPLICATE A DASHBOARD ITEM

e To duplicate a selected control type (dashboard item), click on

Duplicate on either the Home tab or the right click menu.
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* A duplicate of the selected control type (dashboard item) will be

displayed.
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DELETE A DASHBOARD ITEM

e To delete a selected control type (dashboard item), click on

Delete on either the Home tab or the right click menu.
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e The selected control type (dashboard item) will be deleted.
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CONVERT A CONTROL TYPE

1. To change a selected control type (dashboard item), click on Convert
To on either the Home tab or the right click menu.
2. A side menu will pop up, select the control type you wish to convert to.
* In this image, Chart has been selected.
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The control type (dashboard item) will be converted to the selec-

ted control type.

* In this image, a Chart is now displayed.
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REMOVE DATA ITEMS FROM A DASHBOARD ITEM

* To remove data items from a selected control type (dashboard
item), click on Remove Data Items on either the Home tab or
the right click menu.
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* The data items of the selected control type (dashboard item) will

be removed.
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RENAME A DASHBOARD ITEM TITLE AND OR
COLUMNS

e To edit the title and or column names of a selected control

type (dashboard item), click on Edit Names on either the Design
tab or right click menu.

Help v2.5.1.4 - Pg 8 - Printed: 27/06/2024

CO3 Technologies (Pty) Ltd © Company Confidential



TEcHNoLosTes Additional Dashboard Item Options

@ AP: Rec Qutstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 & o x
T
= @
System  New Report
Reports.
AP: Rec Outstandng To Trans X ®.
Home: View Desgn
— AB, mm e [F%d | =
A == |aEE| =3
Show Caption | et Names ||| Horizontal | vertical Merge | Column | Word Wrap | Autofit to | AutoFit| Manual
Lines. Lines Cells | Headers Contents | to Grid
ol s 0 5 Dashboard th
AP: Rec Outstanding To Trans. s
Grid 1 AT
1’4 == Show Caption —
= — Difference (Sum) Outstanding (Sum) Transactions (Sum)
: Rec Outstanding To Tr. - soxoo¢ () Duplicate " Q =
[35] Account 8Ur00] X Delete | 0 = =
[&E] Name GAMOO] @ Convert T * =0 =0 =0
- Ofference (som) | X1 s
] 00§ 0 =0
(3 Difference L= Remove Dats ltems | j = =
[i3] Outstanding
Outst (Sum) 2 Edit Rules
= tandig (Sum) | 3 PRIOOT 0 = =
SPROOT 43, Eit Names | 0 156K 156K
Transactions (Sum) b 2 SPRO0Z = hatonal = 121K 121K
supooy ¥ Edit Fiker | - 0 -
‘New ol @A ToN 0 16K 16K
Maximize
Sane Print Preview.
Argument Export To PDF
Export To Image
1 Export To Excel
| ExpontDsshboard »
_ User : Dugithi Mersion : 1.2.0.3 TEST APHA - JUDITHPC LOCAL

* The Edit Names screen will be displayed.
* Make the required changes.
* Click on Ok.
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* The changes will be saved.
* In this image, the title of the selected control type
(dashboard item title) has been changed from Grid 1
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EDIT DASHBOARD ITEM FILTER

e To add / edit column filters of a selected control type (dashboard

item), click on Edit Filter on the right click menu.
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e The Filter Editor screen will be displayed.
* Click onthe red 'And' text in the Filter Editor.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o X

= @
System  New Report
Reports

AP: Rec Outstandng ToTrans X
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o e i Gid  Chart Scat Pes Gauges Cards Treemap Choropleth GeoFont Range il B reateox Dupicate  Dele it
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= =
Dol Seirce DATA ITEMS 5 Mm@ O 0
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e T
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[E] Account e BUYO01 - o
5] Name GAMODL o )
el
[3] Difference =) > MET001 o o
5] Outstandng PNPOO2 =0 =0
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U0t =) )
New Column [A] o 16K 16K
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P oK Cancel

User : JudthM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL 4|

e This will bring up a drop-down menu with options to change the

current filter selections.
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@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o X

= @
System  New Report
Reports

AP: Rec Outstanding To Trans_ X
tome | Vew  Desgn
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r Edit x
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User : JudthM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL

ﬂ;l
* Click on any one to make changes to the filter selection.
* In this image, Not And has been selected.
@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
:
= @
System  New Report
Reports
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— - ¢ 0 = - O - AB
Biooe eom- T EE@OEIR WY YR Y S @ X O Bl
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j’?xm Outstandng (Sum) | 2 PRIOOL 0 )
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Argument oK Cancel

User : JudthM  2301/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL él

e Not Add instead of 'And' is now displayed in the Filter Editor.
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@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

B
= @
System  New Report

Reports.

49: Rec Qutstandng ToTrans X .

[

Home | View  Desgn

B Lo wow- Tl E QO S
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() clane Chart Map Maps~  Fiter Hements~ Tl Group £33 Edit Rues
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Sparkine
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User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PCLOCAL

2|
. he Fi j lick h jon b
In the Filter Editor, click on the Action button.
@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.03 - o X
] @
System  New Report
[ ap: Recoutstandng ToTrans x | =
\
| Home | Vew = Desion
# ChangelName | .. T m—. (‘ @ == = e O @ ] Images © ComertTo v
E 851 Change Interval = 'III El » - I" ’J ’\‘ b . [] TextBox @ X & Remove Data Items
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Argument oK Cancel
| User: udthi_ 23/D1/2020 Verson: 1203 TESTAPHA- MDITHPCLOCAL |

A

e A list of actions will be displayed.

e Select the required action.

Help v2.5.1.4 - Pg 13 - Printed: 27/06/2024

CO3 Technologies (Pty) Ltd © Company Confidential



TEcHNoLosTes Additional Dashboard Item Options

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

B
= @
System  New Report

Reports.

49: Rec Qutstandng ToTrans X
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= P
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& v 80X0001 0 =
[&] Account - . BUY001 0 =0
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Sparkine
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User : JudithM  23/0/2020 Version: 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL

||

* The selected action will be displayed.
¢ Click on the blue text in brackets (these are the column titles).

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 -

AP:Rec Outstandng ToTrans X

Gnd Tools

Home | Vew  Design

#_ Change Name L — - g ), O @ ] Images © ConvertTo > AB G currency
=] coe - ImEAIEQ@OGER W Y[R Y X e
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Transactons (sum) | 53 sPRo0z N StadsiwitiggAarng];iv) 12 =121
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Sparkine
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| User:JudthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL /d_l

* A list of titles will be displayed.
* Click on any of these titles to change the column that is being
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filtered.

* In this image, the Name column has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

AP: Rec Quistandng To Trans X
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AP:RecOutstandng ToTrans . ~ |  Cokumns Name ~ | Begins with <enter a vahe> @

Raw Data Notoik 1y 52
=081 4% T Account © Name: I =
—————— — Account Transactions (sum)

« (1] AP: Rec Outstanding To Tr - v ey po -
] Account BUY001 0 ")
[35] Name: GAMOOL =0 =
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User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL |

* In this image, the Filter Editor will now displays Name as its
column filter instead of Account.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = C X
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| User:ludthM 23/01/2020 Version:1.2.0.3 TESTALPHA - LDITHPCLOCAL |

|
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Additional Dashboard Item Options

* Click on any one of the green text. (These are all the methods of
filtering available in this data grid.)

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

= @
System  New Report
Reports.
AP;Rec Qutstanding To Trans X b
—_— - 3 = =
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& B3 Change Interval B S SO i m_— AR 0 " [15] TextBox e & Remove Data Items [£8] Edit Colors
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Argument
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User : JudéhM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL

él

* A pop up menu will display a list of the filter method options for
the selected column.

&l

y
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Reports
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AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL /A_I
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* Click on any one of these to select the filter method required.
* In this image the filter method Begins with has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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H v - mEMEQ@GEIRE W H | Y E X Eis
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N . . . . . .
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w AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 - ] X
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| User:ludthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL 2|

* Your filter search parameters needs to be appropriate to the

newly selected column and method.
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e Click on the enter a value text.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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| User:JudthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL

LS

* A text box will appear.
* Type in or click on the down arrow and select an appropriate

parameter that applies to this particular column ( Name) and fil-
ter method ( Begins With).

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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* The text box in the Filter Editor is not case sensitive, you can
type in any part of a word or number.

* In this image, Boxer has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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— SUP001 Not [(Name], ‘Sprint DI s ) o o
New Column [A] TN 16K 16K
Sparkine
Argument
oK Cancel Apply
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1. You can add more filters.

2. You can delete a filter.

3. When you have finished making your filter changes and selections, click
on Apply and Ok to apply these to the dashboard item.
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Additional Dashboard Item Options

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

System  New Report
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# Change Name == e - e Q, 0.0 <] tmages ~ € ComvertTo v
H cwo - mEmMEQ@OGERE W IH[Y X
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(J) Clone Chart Map  Maps~  Fiter Eements~ [ Grop #52 Edit Rules
S e 5 Flter Editor /o x e
AP:RecOutstandng To Trans... | Cokumns. Notand @ ©
Raw Data [Name] Begine with Boxer ,* o<—° 5]
=108 8% 1 Account © [ [
Account Transactions (Sum)
+ [@] AP: Rec Outstanding To Tr. = - BOXDN0T =3 =
[&E] Account ) BUY001 = =
[3E] Name GAMOD1L =0 =0
[3) Difference. Ofference (Sum)_ I METOOL o oy
5] outstandng PNPO02 =0 =0
Outst
Pl tanding (sum) | 3 PRIOO1 = &)
SPRO01 156K 156K
Transactions (Sum) > 3 SPRO02 121K 121K
P00t Not Startswith{(Namel, 'Boxer] Y Y
e Colney & ToN 16K 16K
Sparkine
‘Argument
3 Cancel Apply
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* The selected filter will be applied to the dashboard item.

* In this image, Boxer is no longer displayed in the dashboard item.

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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System  New Report
Reports
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() clone Chart Map  Mapsv  Fitr Eementsv [ Gow £ EditRues [4 parameters
ristory | Insert tem Dashboard
e a Dashboard th %
AP: Rec Outstanding To Trans... | Columns
Raw Data Ty %2
=108 4% = [t Account | & LR
Account Name Difference (Sum) Outstanding (Sum) Transactions (Sum)
~ (@] AP: Rec Outstanding To Tr B - BYO0L By Back Suppier 0 30 0
(3] Account ) GAMOO1 Game 0 0 0
] Name METO0L Metro Peach Distrbutors - - =
i3] Difference | ofference (um) i PNP002 Pick and Pay (Py) Ltd 0 o o
5 Outstanding PRIOOL Printer World (Pty) Ltd 0 o )
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| Transactions (sum) | 30 SUP0OL Buy Back Supplier =0 =0
- TON Tonys Copy Shop =0 =16K =16K
New Column @A)
Sparkine
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Additional Dashboard Item Options

CLEAR A DASHBOARD FILTER

e To clear a column filter on a selected control type (dashboard

item), click on Clear on the right click menu.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o x

B

System  New Report
Reports

w:aecmmaﬁ-p‘;ﬂmsx
i crd
|| Home | wiew = Deson
== - & (-} = - lw - AB
B~ REMEQGO=IRE W % Y o 9 x oo &gl
ve 5

- | Pwot  Gid chart scatter Pes Gaupes Cards Treemap Choropleth GeoPont Range  Filter X Dupicate Delete ¢
Chart Map Maps®  Fiter Hements~ T Group 71 Edit Rules [ Parameters

(3 Clone

Tk Eiae DATA ITEMS

Dashboard th &
AP: Rec Qutstanding To Trans... ~ Columns
=48] 8% T Aot v Raw Data ‘[\— Show Caption th i3
oo - & Aecant freey Difference (Sum) [ SR Tronaoctions (Sum)
- 3] AP: Rec Outstandng ToTr - = T T ——— W — '8 - s o 5
[E] Account e GAMOOL ey X Delete < =
[iE] Neme 5 METO01 Metro Peach Distributors © ConvertTo r ) 0
[&5] Difference e un) PNPO02 Pick and Pay (Pty) Ltd | @ Remove Data tems 0 =
i3] Outstanding FREaL Erer Yo S 5 Edit Rul = -
= Outstandng (Sum) x SPRO0L Sprint Distributors Local il =156K 156K
SPRO02 Sprint Distributors International “» Edit Names 121K =121
Transactions (5um) | 53 ET Buy Back Suppler % EditFilter *0 o
TON Tonys Copy Shop 16K 16K
| % Clear
New Column Al —
Meximize
Sparkine Print Preview.
Argument Export To PDF
Export To Image
Export To Bxcel
Export Dashboard »
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* The column filter will be cleared.
* In this image, Boxer is now displayed in the selected dashboard

item.
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fowem vwe - MEmMEQ@GOSEIRE W 9F Y S
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PRINT PREVIEW A DASHBOARD ITEM
e Click on Print Preview.

Grid Tools
|| Home | Vew  Desgn
o e T E QO

save edo » | POt Gid Chart Scatter Ples Gauges Cards Treemap Choropleth GeoPont Range  Fitter
[ Glone Chart Map Meps~  Fiter Bements *

WY ST B oxem

Dupicate Delete

Do Soprce A n Dashboard th &
AP: Rec Qutstanding To Trans... ~ Columns
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=08 4% = T Aot v =1 Show Caption 0«
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Rec Outstanding To Tr. $ o BOX0001 Duplicate 0 0 0
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Difference (Som) | 53
(53] Difference L=l ; Remove Data ltems j 3 2
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Sparkine Print Preview..
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* The Preview screen will be displayed.
* You can now view the data contained in the dashboard item

before printing.

2 Preview L8 l=]loj x
B Open | B Pt @ |S| [ Margins + i DD evious Page || e | & Zoomout | o a e
1, Quick Print [ Orientation + o Next Page m Q, Zoom ¥
Header/Footer  Scale Find  Thumbnails Ed Firs o, ManyPages B Export | Close
Bl Save | g otions o 0 Siev Fikd: t Page -} - @ Zoomin | B -
Raw Data
\Account  |Name Difference (Sum) Outstanding (Sum) Transactions (Sum)
BOX0001 | Boxer =0 =0 =0
BUY00L Buy Back Supplier =0 =0 =0
GAMODL  |Game =0 =0 =0
MET001 | Metro Peach Distributors =0 =0 =0
PNPOD2  Pick and Pay (Pty)Ltd =0 =0 =0
PRIOO1  |Printer World (Pty)Ltd =0 =0 =0
SPROO1 |Sprint Distributors Lol =0 156K =156K.
SPRO02 Sprint Distril =0 =121K =121K
SUPOD1 | Buy BackSupplier =0 =0 =0
ITON Tonys Copy Shop =0 =16K =16K.
Page 10f 1 | 0% o) L) @ 4

EXPORT TO ....

* You can export data displayed in the dashboard item to PDF or
Image or Excel.
* The Export to Dashboard option gives you the same Export

To... options as above.
®  Note: For more information refer to Export To topic.
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@ AP: Rec Qutstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 - o x
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Related Topics

¢ Change dashboard report title
¢ Set default currency

* Edit dashboard colours

e Change report name

¢ Change report interval

¢ Clone Report

MNU.162.011
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